
 

Excel Cheat Sheet 2010 Quick Guide Chart

Eventually, you will entirely discover a extra experience and endowment by spending more cash. yet when? get you give a positive response that you require to acquire those every needs later having significantly cash? Why dont you try to acquire
something basic in the beginning? Thats something that will lead you to understand even more something like the globe, experience, some places, subsequently history, amusement, and a lot more?

It is your totally own period to play-act reviewing habit. in the course of guides you could enjoy now is Excel Cheat Sheet 2010 Quick Guide Chart below.

Office 2010 Common Features Quick Reference Guide (Cheat Sheet of Instructions, Tips and Shortcuts - Laminated Card) John Wiley & Sons
Let your Excel skills sore to new heights with this bestselling guide Updated to reflect the latest changes to the Microsoft Office suite, this new edition of Excel
For Dummies quickly and painlessly gets you up to speed on mastering the world's most widely used spreadsheet tool. Written by bestselling author Greg
Harvey, it has been completely revised and updated to offer you the freshest and most current information to make using the latest version of Excel easy and
stress-free. If the thought of looking at spreadsheet makes your head swell, you've come to the right place. Whether you've used older versions of this popular
program or have never gotten a headache from looking at all those grids, this hands-on guide will get you up and running with the latest installment of the
software, Microsoft Excel 2016. In no time, you'll begin creating and editing worksheets, formatting cells, entering formulas, creating and editing charts,
inserting graphs, designing database forms, and more. Plus, you'll get easy-to-follow guidance on mastering more advanced skills, like adding hyperlinks to
worksheets, saving worksheets as web pages, adding worksheet data to an existing web page, and so much more. Save spreadsheets in the Cloud to work on
them anywhere Use Excel 2016 on a desktop, laptop, or tablet Share spreadsheets via email, online meetings, and social media sites Analyze data with
PivotTables If you're new to Excel and want to spend more time on your actual work than figuring out how to make it work for you, this new edition of Excel
2016 For Dummies sets you up for success.
Microsoft Excel 2013 Data Analysis with Tables Quick Reference Guide John Wiley & Sons
Do you need a quick reference for Excel for Microsoft 365? The four-panel Excel for Microsoft 365 Reference &
Cheat Sheet contains tips, examples, and screenshots of basic Excel functions and features. A list of keyboard
shortcuts for Windows and macOS is also included. Fully recyclable and designed for readability.

Microsoft Excel 2013 Functions and Formulas Quick Reference Card (4-Page Cheat Sheet Focusing on Examples and Context for Intermed Wiley-
Blackwell
Geared toward the intermediate to advanced Excel 2016 user, this example-rich 4-page laminated card/guide provides explanations and context for
many powerful Excel 2016 spreadsheet formulas and functions. Step-by-step instructions for many formula/function-related features such as using
range names, and Excel's troubleshooting features. Written with Beezix's trademark focus on clarity, accuracy, and the user's perspective, this guide
will be a valuable resource to improve your proficiency in using Microsoft Excel 2016. This guide is suitable as a training handout, or simply an easy
to use reference guide.Topics include:Controlling Order of PrecedenceConditionally Summing/Counting Data (SUMIF, COUNTIF)Being Precise
(Rounding functions)Improving Clarity with Range Names: Creating Names, Limiting Scope, Defining a Constant or Formula for a Name, Managing
Names, Indirectly Referring to a Named Range (INDIRECT)New Functions for Office 365, Mobile & Online (CONCAT, TEXTJOIN, IFS,
MAXIFS/MINIFS, SWITCH)Merging Text and Numbers (CONCATENATE, TEXT, LEFT, RIGHT, MID, LEN, FIND, VALUE, TRIM,
SUBSTITUTE)Changing Results: IF, AND, OR, NOTTable Lookups (VLOOKUP, HLOOKUP, INDEX, MATCH)Error Recovery (ISNA,
ISERROR)Array Formulas (Single Cell & Multi-Cell Arrays)Dates and Times (DATE, YEAR, MONTH, DAY, TODAY, WEEKDAY, NETWORKDAYS,
EDATE)Using a Formula for Data ValidationTroubleshooting: Types of Errors, Automatic Error Checking, Using the Error Checker, Showing/Hiding
Formulas, Evaluating Nested Formulas, Selecting Related Cells, Displaying Cell Relationships, Removing Relationship Arrows. Examples: Summing
Selected Data; Being Precise; Merging Text & Numers; Table Lookups; Table Lookups with IF and ISERROR; Dates & Times; Single- and Multi-Cell
Arrays.
Microsoft Excel 2016 Functions and Formulas Quick Reference Card (4-Page Cheat Sheet Focusing on Examples and Context for Intermed
TeachUcomp Inc.
4-page laminated quick reference guide showing instructions for the new and changed features of Microsoft Office 2013 for Word, Excel, and
PowerPoint for users upgrading from Office 2010. Also includes a command reference for each product, showing changed Office 2010 commands and
their Office 2013 equivalents. Topics: Office: The Start Screen; Local (Custom) Templates; Changing the Look of Office; Optimizing for Touch; Using
the Touch Mini-Toolbar; Integration with Online Services: Signing into an Online Account (SkyDrive SharePoint), Switching Online Accounts, Adding
a Service Such As Flickr, YouTube, SkyDrive, Office 365 SharePoint; Opening the Folder Your Current Document is in; Opening and Saving; Inviting
People to Collaborate on a SkyDrive Document; Viewing/Changing Access to a Document; Using On-object Chart Tools; Presenting Online; Using
Apps for Office; Other New or Changed Features; Communicating with a Commenter; Replying to a Comment; Features No Longer Available. Word:
Tracking Changes; Switching Between Simple Markup and All Markup; Locking Track Changes On; Expanding Collapsed Comments; Marking
Comments as Done; Resuming Reading; Read Mode; Collapsing/Expanding Parts of a Document in Print Layout View; Opening and Editing a PDF;
Using Alignment Guides; Text Wrapping with the Layout Options Tool; Quickly Inserting Rows/Columns Within a Table; Using the Border Painter;
Copying Border Style (Border Sampler); Repeating Section Form Control; Other New or Changed Features. PowerPoint: Creating New Shapes (Merge
Shapes); Zoom and Pan While Presenting; Jumping to a Slide; Widescreen; Applying Design Theme Variants; Changes to Guides; Using Eyedropper to
Match Colors; Using Smart Guides; Paying Audio for Several Slides; Other New or Changed Features; Features No Longer Available. Excel: Excel
Windows; Using Flash Fill; Using Chart Recommendations; 3-D Pyramid and Cone Chart Types; Combining Chart Types; Changes to Chart Data
Labels; New Data Label Formatting; Using Quick Analysis; Filtering Tables with Slicers; Using PivotTable Recommendations; PivotTable and
PivotChart Changes: Adding and Using a Timeline, Creating a PivotChart with or without a Table, Using a PivotTable to Analyze Multiple Data
Sources; Advanced Data Analysis: Creating a Power View Sheet, Adding a Visualization to Power View; New Functions; Other New or Changed

Features; Features No Longer Available.
Excel 2010 Workbook For Dummies John Wiley & Sons
Reinforce your understanding of Excel with these Workbook exercises Boost your knowledge of important Excel tasks by putting your skills to work in
real-world situations. The For Dummies Workbook format provides more than 100 exercises that help you create actual results with Excel so you can
gain proficiency. Perfect for students, people learning Excel on their own, and financial professionals who must plan and execute complex projects in
Excel, Excel 2010 Workbook For Dummies helps you discover all the ways this program can work for you. Excel is the world's most popular number-
crunching program, and For Dummies books are the most popular guides to Excel The Workbook approach offers practical application, with more than
100 exercises to work through and plenty of step-by-step guidance This guide covers the new features of Excel 2010, includes a section on creating
graphic displays of information, and offers ideas for financial planners Also provides exercises on using formulas and functions, managing and securing
data, and performing data analysis A companion CD-ROM includes screen shots and practice materials Excel 2010 Workbook For Dummies helps you
get comfortable with Excel so you can take advantage of all it has to offer. Note: CD-ROM/DVD and other supplementary materials are not included as
part of eBook file.
SharePoint 2010 Web Apps Quick Reference Guide (Cheat Sheet of Instructions, Tips and Shortcuts - Laminated Card) Carolina Academic
Press
Laminated quick reference card showing step-by-step instructions and shortcuts for how to use Microsoft Office Excel 2010. This guide is
suitable as a training handout, or simply an easy to use reference guide, for any type of user. The following topics are covered: Creating
Workbooks, Entering and Editing Data, Undo and Redo, Resizing Column Width and Row Height, Inserting and Deleting Rows Columns
and Cells, Clearing Cells, Clearing Formatting, Formatting Numbers and Cells, Aligning and Merging Cell Contents, Borders and Grids,
Viewing the Worksheet as it will Print, Entering Dates, Entering Sequences. Entering Formulas & Functions, Entering a SUM Function
Quickly, Absolute vs. Relative Cell References. Copying and Moving Data: Copying to Adjacent Cells; Cut, Copy, Paste; Drag & Drop.
Sheet Features: Renaming, Moving, Copying, Selecting, Inserting, Deleting Sheets. Editing Multiple Worksheets Simultaneously, Copying
Data and Formatting to Multiple Worksheets. Previewing, Printing and Page Setup, Printing a Specific Area, Using Page Break Preview to
Adjust Page Breaks, Repeating Rows/Columns on Every Page. Working with Previous Versions (Compatibility Mode). Also includes: Lists
of Selection and Movement Shortcuts. This guide is one of several titles available for Excel 2010: Excel 2010 Introduction; Excel 2010
Tables, PivotTables, Sorting & Filtering; Advanced & Macros; Charts & Sparklines; Functions & Formulas.
Microsoft Excel 2013 Advanced and Macros Quick Reference Guide John Wiley & Sons
4-page laminated quick reference guide showing instructions for the new and changed features of Microsoft Office 2010 for Word, Excel,
and PowerPoint for users upgrading from Office 2003. Also includes a command reference for each product, showing Office 2003
commands and their Office 2010 equivalents. Topics include: Office: The Ribbon; Backstage View (The File Menu); Quick Access Toolbar;
Formatting Text with the Mini Toolbar; Pasting with Live Preview; Saving as PDF; Emailing a PDF; Co-authoring (Word/PowerPoint);
Work Anywhere (Office Web Apps); Using Themes to Format a Document; SmartArt; Shape Styles; New or Changed Picture Features;
Showing Macro and Form Controls; New File Formats; Working with Preview File Versions; Other New or Changed Features; Features No
Longer Available. Word: Spacing between Paragraphs; Showing the Ruler; Contextual Spelling; Navigating and Reorganizing using
Headings; Searching Using the Navigation Pane; Creating and Using Quick Styles; Using the Apply Styles Window; Mail Merge; Building
Blocks; Creating a Quick Part Building Block; Inserting a Quick Part; The Reviewing Pane; Tracking Moved Text; Improved Compare and
Combine; Other New or Changed Features; Features No Longer Available. Excel: Limit Changes; Resizing the Formula Bar; Formula
AutoComplete; Improvements to Named Ranges; Inserting a Sheet; Page Layout View; Showing Invalid Data; Pasting Cells as a Linked
Picture; Changes to Excel Tables (Lists); Structured References in Excel Tables; Filtering Pivot Tables with Slicers; Other PivotTable
Changes; Inserting a Chart in a Cell (Sparklines); Filter Improvements; New Conditional Formatting; Sorting by Icon, Cell Color, or Font
Color; Other New or Changed Features. PowerPoint: Organizing Slides with Sections; Resetting Placeholders; Adding Placeholders to a
Slide Master; Adding a Customized Layout; Background Styles; New or Changed Text Features; Using the Animation Painter; Video
Improvements; Linking to a Web Video; Syncing Animation/Text Overlays with Audio/Video; Creating a Video File; Broadcasting Using
the Internet; Other New or Changed Features; Features No Longer Available. This guide is suitable as a training handout, or simply an easy
to use reference guide, for any type of user.
Excel 2016 For Dummies John Wiley & Sons
Designed with the busy professional in mind, this 4-page laminated quick reference guide provides step-by-step instructions in Introductory Excel 2016.
When you need an answer fast, you will find it right at your fingertips. Durable and easy-to-use, quick reference cards are perfect for individuals,
businesses and as supplemental training materials. With 59 topics covered, this guide is perfect for someone new to Excel or upgrading from a previous
version.Topics Include: Interface Basics, File Management, Data Entry, Formulas, Copying and Pasting Formulas, Adjusting Columns and Rows,
Formatting Worksheets, Worksheet Tools, Worksheet Layout, Printing, Touch Actions and Keyboard Shortcuts.
Microsoft Word 2010 Advanced Quick Reference Guide (Cheat Sheet of Instructions, Tips and Shortcuts - Laminated Card) John Wiley & Sons
Geared toward the intermediate to advanced Excel 2011 user, this example-rich 4-page laminated quick reference card/guide provides explanations and context for
many powerful Excel 2011 spreadsheet formulas and functions. Step-by-step instructions for many formula/function-related features such as using range names, and
Excel's troubleshooting features. This guide is suitable as a training handout, or simply an easy to use reference guide. The following topics are included: Glossary.
Conditionally Summing/Counting Data (SUMIF, COUNTIF). Being Precise (Rounding): (ROUND, MROUND, ROUNDUP, CEILING, CEILING.PRECISE,
EVEN, INT). Improving Clarity with Range Names: Name Rules, Creating a Name, Creating Several Names at Once, Selecting a Name Range, Using a range Name
in a Formula, Managing Names, Indirectly Referring to a Named Range (INDIRECT). Merging Text and Numbers (CONCATENATE, TEXT, LEFT, RIGHT,
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MID, LEN, FIND, VALUE, TRIM, SUBSTITUTE). Changing Results (IF, AND, OR). Table Lookups (VLOOKUP, HLOOKUP, INDEX, MATCH). Error
Recovery (ISNA, ISERROR). Array Formulas (Single Cell & Multi-Cell Arrays). Dates and Times (DATE, YEAR, MONTH, DAY, TODAY, WEEKDAY,
NETWORKDAYS). Using a Formula for Data Validation. Troubleshooting: Types of Errors, Automatic Error Checking, Using the Error Checker, Showing/Hiding
Formulas, Displaying Cell Relationships, Selecting Related Cells, Removing Relationship Arrows. This guide is one of several titles available for Excel 2011: Excel
2011 Introduction; Excel 2011 Charts, Tables & PivotTables; Excel 2011 Functions & Formulas.
101 Ready-to-Use Excel Formulas John Wiley & Sons
Laminated quick reference card showing step-by-step instructions and shortcuts for how to use tables, PivotTables, sorting and filtering features in
Microsoft Office Excel 2013. This guide is suitable as a training handout, or simply an easy to use reference guide, for any type of user. The following
topics are covered: List Range or Table? Excel Tables: Creating an Excel Table, Adding or Deleting a Table Row or Column, Turning On/Off the Total
Row, Removing Duplicates, Using Table Specifiers in Formulas, Converting a Table to a List Range, Using a List Range for Sorting, Filtering,
Subtotals, and PivotTables. PivotTables: Creating a PivotTable or PivotChart from Worksheet Data, Show/Hide the PivotTable Fields Pane,
Adding/Removing a PivotTable Field, Refreshing a PivotTable, Rearranging a PivotTable, Adding a PivotChart to an Existing PivotTable, Changing
the Summary Function, Changing How Values are Shown, Sorting and Filtering a PivotTable, Filtering PivotTables with Timelines, Using a PivotTable
to Analyze Multiple Data Sources, Adding Excel Workbook Tables to the Data Model, Adding External Data to the Data Model, Defining
Relationships Across Multiple Tables, Creating a New PivotTable to Analyze Multiple Data Model Tables, Adding Tables and Fields to an Existing
PivotTable, Advanced Data Analysis, Creating a Power View Sheet, Adding a Visualization to Power View. Sorting & Filtering a Table or List Range:
Basic Sorting, Complex Sorting, Filtering and Advanced Filtering, Show/Hide AutoFilter, Filtering with AutoFilter. Advanced Filtering: Criteria for
Advanced Filters, Using Advanced Filters/Copying Filtered Data to Another Range, Selecting/Ordering Columns, Clearing Filtering and Sorting,
Subtotals. This guide is one of several titles available for Excel 2013: Excel 2013 Introduction; Excel 2013 Data Analysis with Tables; Functions &
Formulas.
What's New in Microsoft Office 2013 (from 2010) Quick Reference Guide (Cheat Sheet of New Features and Instructions) For Dummies
Dig into formulas, functions, and more to build your Excel skills Whether you're a beginner or an Excel veteran, this friendly guide provides the
fundamental techniques to help you create, edit, format, and print your own spreadsheets. You'll start from scratch and quickly progress to manipulating
data with formulas and using Excel's extensive formatting options to present your information in the most powerful way. Open the book and find: Ways
to navigate Excel's Ribbon interface Data entry tips to start your spreadsheet How to build formulas and edit workbooks Formatting steps to follow
Printing basics to present your data
Microsoft Word 2010 Mail Merge and Forms Quick Reference Guide (Cheat Sheet of Instructions, Tips and Shortcuts - Laminated Card) John
Wiley & Sons
Laminated quick reference card showing step-by-step instructions and shortcuts for how to use advanced features of Microsoft Office Word 2010. This
guide is suitable as a training handout, or simply an easy to use reference guide, for any type of user. The following topics are covered: Using Styles,
Character, Paragraph, Linked Styles, Applying Character and Paragraph Styles, Creating a Style, Displaying the Styles Pane, Disabling Linked Styles,
Changing Styles, Deleting a Style, Selecting All Text with the Same Style, Showing Formatting as Styles to Clean Up a Document, Importing Styles
from Another Document, Using Numbered Lists with Styles, Adding Styles to the Default List, Applying Table Styles, Restricting Formatting, Creating
a Table of Contents, Updating a Table of Contents, Preparing an Index, Generating an Index, Updating an Index, Section Breaks, Inserting a Section
Break, Changing Page Numbering Mid-Document, Changing Headers and Footers, Changing Page Setup in a Section, Displaying the Section Number
in the Status Bar, Inserting a Footnote/Endnote, Editing a Footnote/Endnote, Deleting a Footnote/Endnote, Creating a Bookmark, Going to/Selecting
Bookmarked Text, Using Bookmarks to Refer to Pages, Outlining, Adding a Watermark, Inserting an Excel Spreadsheet, Comparing Documents Side
by Side, Creating a Template Library in Windows 7, Creating a Template. This guide is one of several titles available for Word 2010: Word 2010
Introduction, Word 2010 Formatting, Word 2010 Advanced, Word 2010 Mail, Merge & Forms, Word 2010 Templates & Macros, Word 2010
Collaboration Features.
Microsoft Access 2010 Intermediate Quick Reference Guide (Cheat Sheet of Instructions, Tips and Shortcuts - Laminated Card)
Professors Fischl and Paul explain law school exams in ways no one has before, all with an eye toward improving the reader’s performance.
The book begins by describing the difference between educational cultures that praise students for “right answers,” and the law school
culture that rewards nuanced analysis of ambiguous situations in which more than one approach may be correct. Enormous care is devoted to
explaining precisely how and why legal analysis frequently produces such perplexing situations. But the authors don’t stop with mere
description. Instead, Getting to Maybe teaches how to excel on law school exams by showing the reader how legal analysis can be brought to
bear on examination problems. The book contains hints on studying and preparation that go well beyond conventional advice. The authors
also illustrate how to argue both sides of a legal issue without appearing wishy-washy or indecisive. Above all, the book explains why exam
questions may generate feelings of uncertainty or doubt about correct legal outcomes and how the student can turn these feelings to his or her
advantage. In sum, although the authors believe that no exam guide can substitute for a firm grasp of substantive material, readers who
devote the necessary time to learning the law will find this book an invaluable guide to translating learning into better exam performance.
“This book should revolutionize the ordeal of studying for law school exams… Its clear, insightful, fun to read, and right on the money.” —
Duncan Kennedy, Carter Professor of General Jurisprudence, Harvard Law School “Finally a study aid that takes legal theory seriously…
Students who master these lessons will surely write better exams. More importantly, they will also learn to be better lawyers.” — Steven L.
Winter, Brooklyn Law School “If you can't spot a 'fork in the law' or a 'fork in the facts' in an exam hypothetical, get this book. If you don’t
know how to play 'Czar of the Universe' on law school exams (or why), get this book. And if you do want to learn how to think like a
lawyer—a good one—get this book. It's, quite simply, stone cold brilliant.” — Pierre Schlag, University of Colorado School of Law (Law
Preview Book Review on The Princeton Review website) Attend a Getting to Maybe seminar! Click here for more information.
Microsoft Excel 2013 Introduction Quick Reference Guide (Cheat Sheet of Instructions, Tips and Shortcuts - Laminated Card)
Laminated quick reference card showing step-by-step instructions and shortcuts for how to use tables, PivotTables, sorting and filtering features in Microsoft Office
Excel 2010. This guide is suitable as a training handout, or simply an easy to use reference guide, for any type of user. The following topics are covered: Excel
Tables: Creating an Excel Table, Changing the Table Area, Adding a New Row or Column to the Table, Deleting a Table Row or Column, Turning On/Off the Total
Row, Changing the Total Row, Convert a Table to a Normal Range, Using a Normal Range for Sorting, Filtering, Subtotals, and PivotTables, Removing Duplicates,
Structured References in Excel Tables. PivotTables: Creating a PivotTable or PivotChart Report, Show/Hide the PivotTable Field List, Adding/Removing a
PivotTable Field, Refreshing a PivotTable, Rearranging a PivotTable, Adding a PivotChart to an Existing PivotTable, Changing the Summary Function, Changing
How Values are Shown, Sorting in a PivotTable, Grouping by Dates or Time, Filtering PivotTables and Charts with Slicers. Sorting & Filtering: Basic Sorting,

Complex Sorting, Re-applying a Sort, Creating a Custom List, Creating a Custom List from Cell Data, Sorting Using a Custom List, Filtering and Advanced Filtering,
Show/Hide AutoFilter, Searching for Filter Criteria in AutoFilter, Criteria for Advanced Filters, Using Advanced Filters/Copying Filtered Data to Another Range,
Selecting /Ordering Columns, Filter/Copy Unique Rows, Clearing Filtering and Sorting, Subtotals. This guide is one of several titles available for Excel 2010: Excel
2010 Introduction; Excel 2010 Tables, PivotTables, Sorting & Filtering; Advanced & Macros; Charts & Sparklines; Functions & Formulas.
Excel 2011 for Mac
Crunch numbers the easy way with Excel 2010 This handy mini guide is packed with the information you need to become a spreadsheet superstar! You’ll learn to
find your way around Excel 2010, enter data on a worksheet, create simple formulas, format cells, preview and print pages, and more. Whether you’re new to Excel
2010 or new to Excel altogether, the basics are all here. Open the book and find: Ten cool Excel 2010 features How to navigate the Ribbon A guide to formatting
cells Where to turn for online help How to make your spreadsheets look the way you want

Microsoft Excel 2007 Advanced and Macros Quick Reference Guide (Cheat Sheet of Instructions, Tips and Shortcuts - Laminated Card)
Laminated quick reference guide showing step-by-step instructions and shortcuts for how to use advanced features and macros in Microsoft
Office Excel 2016. Written with Beezix's trademark focus on clarity, accuracy, and the user's perspective, this guide will be a valuable
resource to improve your proficiency in using Microsoft Excel 2016. This guide is suitable as a training handout, or as an easy to use
reference guide, for any type of user. The following topics are covered: Advanced Features: Organizing with Grouping - Manual, Automatic,
Hiding or Displaying a Group, Ungrouping; Hiding Columns, Rows, or Sheets; Consolidating Data; Freezing or Splitting Rows/Columns;
Using the Selection Pane; Conditional Formatting; Goal Seek; Scenarios; Converting Text to Data; Intercepting Entry Errors with Data
Validation; Preventing Changes (Protecting Cells, Worksheets, and Workbooks); Quick Analysis.. Macros: Recording Workbook Actions;
Running a Macro; Executing Macros Automatically; Saving a Macro; Showing the Developer Tab; Setting Macro Security; Assigning a
Macro to a Worksheet Button; Assigning a Macro to the Quick Access Toolbar; Editing a Macro; VBA; Debugging VBA Code;
Documenting VBA Code; VBA Examples: Subroutines, Function Macros; Macro Name Rules.
Microsoft Excel 2010 Introduction Quick Reference Guide (Cheat Sheet of Instructions, Tips and Shortcuts - Laminated Card)
Laminated quick reference card showing step-by-step instructions and shortcuts for how to use Microsoft Office Access 2010. This guide is
suitable as a training handout, or simply an easy to use reference guide, for any type of user. The following topics are covered: Table Design:
Preventing Data Entry Errors, Find and Sort More Quickly With Indexing, Joining Tables to Create Relationships, Deleting a Table Join,
Preventing Orphaned Data with Referential Integrity. Query Design: Performing Calculations, Summarizing Selected Data. Form Design:
Adding Form Controls, Sorting, Removing Automatic Labels, Modifying Automatic Labels, Modifying Form Controls. Report Design:
Summarizing by Group, Printing Options. Table Relationships. Complex Expressions Examples. Form Control. This guide is one of two
available titles for Access 2010: Access 2010 Introduction and Access 2010 Intermediate.
?????????????
Laminated quick reference guide showing step-by-step instructions and shortcuts for how to use advanced features and macros in Microsoft Office
Excel 2007. The following topics are covered: Range Names - Naming a Range, Creating Several Names at Once, Limiting the Scope of a Named
Range, Selecting a Named Range, Using a Range Name in a Formula, Managing Named Ranges, Structured References for Excel Tables; Mixed
Reference; More Functions; Goal Seek; Saving Views; Defining Scenarios; Hiding Columns, Rows, or Sheets; Data Consolidation; Restricting Cell
Entry with Data Validation; Highlighting Invalid Data; Conditional Formatting; Conditional Formatting Rules Manager; Protecting/Unprotecting
Worksheets; Password Protecting Specific Cells. Macros: Showing the Developer Tab; Recording & Running a Macro; Naming a Macro; Relative vs.
Absolute Recording; Documenting Macros; Assigning a Macro to the Quick Access Toolbar; Automatic Macro Execution; Creating a Macro without
Recording; Calling another Macro, Setting Macro Security; Getting Help on Visual Basic; Creating a Function Procedure. This guide is suitable as a
training handout, or simply an easy to use reference guide, for any type of user. This guide is one of several titles available for Excel 2007: Excel 2007
Introduction, Excel 2007 Charts & Tables, Excel 2007 Advanced & Macros.
Microsoft Excel 2010 Tables, PivotTables, Sorting and Filtering Quick Reference Guide (Cheat Sheet of Instructions, Tips and Shortcu
Laminated quick reference guide showing step-by-step instructions and shortcuts for how to use advanced features and macros in Microsoft Office Excel 2013. This
guide is suitable as a training handout, or as an easy to use reference guide, for any type of user.The following topics are covered:Organizing with Grouping: Hiding
Columns, Rows or Sheets, Consolidating Data, Freezing or Splitting Rows/Columns, Using the Selection Pane, Conditional Formatting, Goal Seek, Scenarios,
Converting Text to Data, Intercepting Entry Errors With Data Validation, Preventing Changes (Protecting Data), Quick Analysis.Macros: Recording Workbook
Actions, Running a Macro, Executing Macros Automatically, Saving a Macro, Showing the Developer Tab, Setting Macro Security, Assigning to a Worksheet
Button, Assigning to the Quick Access Toolbar, Editing a Macro, Visual Basic for Applications, Debugging VBA Code, Documenting VBA Code, VBA Examples
to Enhance Productivity: Subroutines, Function Macros, Macro Name Rules.
Excel 2010 - No Problem!
Laminated quick reference card showing step-by-step instructions and shortcuts as well as general document management for the Word, Excel &
PowerPoint web apps available in SharePoint 2010. Intended for users familiar with the desktop Microsoft Office suite. Suitable for BOTH Windows
and Mac end users. Topics include: General: Creating a New Document, Opening Existing Documents, Saving and Closing Documents, Checking
Documents In & Out, Uploading Files, Creating Folders, Renaming Items, Deleting & Restoring Documents, Web App Limitations, Browser & Format
Support Word Web App: Using Reading View, Using Edit View, Collaborating with Others, Printing Documents. Excel Web App: Using Reading
View, Using Edit View, Collaborating with Others. PowerPoint Web App: Using Reading View, Using Edit View, Collaborating with Others. Also
includes a list of Word, Excel & PowerPoint keyboard shortcuts.
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